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IMPORTANT SAFETY INFORMATION 
 
The Load Cell Monitor 100 is a sophisticated load sensing solution that has been designed with safety as a 
primary concern.  However, as with any load monitoring system it is the end users responsibility to carry out 
a full risk assessment of their application.  You must ensure that the monitoring system used is suitable for 
your application and is used in the correct manner. 
 

• Always carry out a full risk assessment of your application. 

• Always ensure that all relevant sections of this manual have been read and fully understood 
before operating the Load Cell Monitor 100. 

• Always check any load cells connected to the Load Cell Monitor 100 are properly 
maintained according to your risk assessment and the manufacturer’s instructions. 

• Only allow suitably trained persons to operate the Load Cell Monitor 100 

• The Load Cell Monitor 100 is for use by professionals only. 
 

Safety should be your prime concern.  If in any doubt seek professional advice. 
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INTRODUCTION 
 
The Load Cell Monitor 100 is fully featured digital load cell monitoring system, combining powerful setup and 
reporting features with ease of use.  Using fully embedded processors for ultimate reliability the Load Cell 
Monitor 100 constantly reads the live weight from each connected load cell.  As well as displaying the 
weights on its front panel LCD screen, and optionally via a PC full screen display, it also compares the 
individual weights to user defined maximum weights.  Should any load cell exceed its maximum weight 
setting an alarm is immediately triggered and a log of the overload event is stored.  In addition to the front 
panel sounder and indicator, a relay output provides alarm condition signalling to an external system or high 
volume sounder. 
 

 
 
FEATURES 
 
The Load Cell Monitor 100 provides the following powerful features: 
 

• Monitoring of up to 100 digital load cells 
• Log history of alarm events and automatic daily weight readings 
• Load cells are connected in a ‘daisy chain’ fashion using a single 4 core cable, with up to 25 load 

cells per cable 
• Opto isolated data connections on each output port 
• Built in power supply provides low voltage power to the load cells 
• Live load cell weight display on the front panel LCD screen 
• Each load cell may be assigned a maximum weight with audible and visual alarm should a maximum 

weight be exceeded 
• Two volt free relay outputs to provide external alarm signalling 
• Optional password protection to stop unauthorised users altering settings 
• Fully embedded processor design - no reliance on PC technology or operating systems 
• Optional full screen weights display using a PC connected to the Ethernet port.  One or more PC’s 

running the IBEX Hoist-Net PC application may be used to view all channels at once, with user 
configurable screen layout. 

 
The Load Cell Monitor 100 Plus model provides these additional features: 
 

• Automatic alarm event notification via the internet to a user defined email address 
• Automatic periodic sending of the log history over the internet via email 
• Remote request for live weights and log data over the internet via email 
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CONNECTIONS 
 
 

 
 
 

POWER 
 
Power is provided via an IEC plug. 
 
Mains input voltage 85 – 260VAC 50/60Hz 
 
Operating current Up to 1.65A (10A or higher type C circuit breaker recommended for brief power on 

surge current) 
 
This product must be earthed. 
 
 

LOAD CELLS 
 
This product is designed to be used with load cells that incorporate the Mantracourt DCell RS485 ASCII load 
cell amplifier.  This is an industry standard miniature OEM amplifier module widely used by load cell 
manufacturers.  Each load cell should incorporate a 4 pin ‘in’ and a 4 pin ‘out’ connection. 

 
Note that Load Cell Monitor 100 will automatically set the baud rate of the load cells on power-up to 4 
(38K4), if the load cells have previously been set to baud rate 7 (115K2), 6 (76K8), 5 (57K6), 3 (19K2) or 2 
(9K6). 

 
Four 4 pin XLR sockets are provided: 

Pin Connection Cable 
1 0V Pair 1-A + Screen 
2 Data- Pair 2-A 
3 Data+ Pair 2-B 
4 +12V Pair 1-B 

 
Each socket provides 12VDC max 1.6A (protected by internal self resetting electronic fuse). 
 
Each Load Cell connection may have up to 25 load cells connected.  The connections are named Port 1 to 
Port 4. 
 
Cable requirements 
 
A 2 twisted pairs cable suitable for RS485 data should be used with an overall screen 
 
All connected cabling must be rated at a minimum of 1.6A. 

 
If long cable runs are used a cable with sufficient gauge should be used to avoid voltage drop (e.g. 22AWG 
or 20AWG (note that AWG core sizes work in reverse – e.g. 20AWG is bigger than 22AWG). 
 
The load cells must be connected in daisy chain format, with a terminating resistor plug fitted at the end of 
the chain (120ohm resistor wired between pins 2 and 3).  ‘Y’ splits in the cable run are not permitted. 
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Load Cell Setup Socket 
 
This connection may be used to detect and program the RS485 network node address of a single connected 
load cell. 
 
 

ALARM 
 
A 5 pin XLR socket is provided for external alarm signalling: 

 
Pin Connection 
1 Common 
2 Alarm 1 
3 Alarm 2 
4 +12V 
5 0V 

 
Each of the alarm outputs is a normally open volt free relay contact rated at 500mA 24V DC/AC.  When an 
alarm is active the relay contact closes. 
 
The +12VDC output may be used to power external devices if required.  Maximum current 900mA (protected 
by an internal self resetting electronic fuse). 
 
 
Alarm 1 
Load Cell Overload. 
Remains active while any load cell weight is higher than its configured maximum weight.  This signal is 
cleared if the Alarm is silenced using the front panel Silence button. 
 
 
Alarm 2 
Load Cell Error. 
Remains active while any channel that is configured to read a load cell does not receive a response from the 
load cell.  This signal is cleared if the Alarm is silenced using the front panel Silence button. 
 
The two alarm signals may be commoned together if a single external alarm is required. 
 
 
Monitoring Active 
If an indication of the unit being powered and the load cells therefore being monitored is required then the 
+12V output may be used.  Connect to an external indicator to confirm the unit is operating, or to an external 
relay to provide an external alarm should the unit not have power. 
 
 
Alarm Activation 
To avoid false alarms from brief overloads (due to say hoists starting and stopping) an alarm condition is 
only triggered after two successive overload readings. 
 
 

ETHERNET 
 
The 10Base-T Ethernet port allows the unit to be connected to a standard Ethernet network, or directly to a 
PC Ethernet port. 
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OPERATION 
 
 

STATUS SCREEN 
 

    11::  TTrruussss  AA--11                        11664400KKgg  
    22::  TTrruussss  AA--22                        11664400KKgg  
    33::  TTrruussss  AA--33                        11664400KKgg  
    44::  TTrruussss  BB--11                        11664400KKgg  
    55::  TTrruussss  BB--22                        11664400KKgg  
    66::  TTrruussss BB--33            11664400KKgg 

1144::1100    0011//0011//22000088 
 
The main status screen displays the current weight of each of the 100 channels.  This is the default screen. 
 
Use the up and down buttons or numeric keypad to select channel numbers to view. 
 
The current time and date are shown at the bottom of the screen. 
 
 

LOAD CELL ALARM 
 
Overload Alarm 
 

LLOOAADD CCEELLLL AALLAARRMM 
CChhaann    44  TTrruussss  BB--11  

------OOVVEERRLLOOAADD  AALLAARRMM------  
              AAllaarrmm  WWeeiigghhtt::      22006600KKgg  
                  WWeeiigghhtt  NNooww::      22115500KKgg  
                    MMaaxx  WWeeiigghhtt::      22000000KKgg  

 
The Load Cell Monitor constantly compares the received weight of each load cell with the user configurable 
maximum weight.  Should a load cell return a reading above the maximum weight on two successive reads 
(to avoid nuisance tripping caused by brief shock loads) the overload alarm is triggered.  The internal 
sounder activates, alarm output 1 is activated and the Alarm indicator flashes. 
 
The channel that has overloaded is displayed together with its name if it has one.  The following status 
information is shown: 
 Alarm Weight  The weight reading that initially caused the alarm 
 Weight Now  The current weight of the load cell 
 Max Weight  The user set maximum weight 
 
 
No Response Alarm 
 
 

LLOOAADD CCEELLLL AALLAARRMM 
CChhaann    44  TTrruussss  BB--11  

----NNOO  RREESSPPOONNSSEE  AALLAARRMM----  
LLooaadd  CCeellll  iiss  nnooww::  
NNoott  rreessppoonnddiinngg  

 
Should the Load Cell Monitor 100 be unable to read the weight from a load cell on two successive attempts 
a no response alarm is triggered.  The internal sounder activates, alarm output 2 is activated and the Alarm 
indicator flashes. 
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The channel that is not responding is displayed together with its name if it has one.  The current status of the 
load cell is also shown. 
 
 
Alarms General 
The Silence button may be pressed to stop the internal sounder and external alarm output.  The silence 
function will remain active for 5 seconds after an alarm condition clears, in case the alarm quickly re-occurs 
(for instance if a load cell weight is changing across the maximum weight value) 
 
If an alarm condition clears (the load cell weight falls below the maximum or the load cell starts responding 
again) the internal sounder and alarm output are automatically reset but the alarm screen will continue to be 
shown until the Exit button is pressed, ensuring that a user see’s the alarm event, unless a new alarm 
condition occurs on another channel which will cause the new alarm condition to be shown instead. 
 
When either of the alarm screens are shown the menu functions are accessible as normal using the Menu 
button.  To hide the shown alarm screen and view the general status screen press the Silence button a 
second time. 
 
 

MAIN MENU 
 
Pressing the Menu button enters the main menu. 
 

MMAAIINN MMEENNUU 
  
  
<<  VViieeww  LLooggss  
<<  UUttiilliittiieess  
<<  SSeettuupp  

 
Select the sub menu to enter, or press exit. 
 
Note that pressing the Menu button whilst in a menu allows you to exit straight back to the default status 
screen. 
 
 

VIEW LOGS 
 

VVIIEEWW LLOOGGSS 
LLoogg  eennttrriieess  aarree  sshhoowwnn  

ssttaarrttiinngg  wwiitthh  mmoosstt  
rreecceenntt..  UUssee  tthheessee  

bbuuttttoonnss  ttoo  nnaavviiggaattee  
<<  PPRREEVVIIOOUUSS                              NNEEXXTT>>  

 
The Load Cell Monitor will create a new log entry for the following events:- 
 
 Power-up  Informs you if the unit lost power and the time and date power returned 
 
 When the clock is set Informs you when the time or date was changed 
 
 Every day at 4am An automatic log occurs at 4am every day 
 
 Alarm event  A log is stored when an alarm event occurs. 

Note that only a single log is stored for each alarm event, to avoid multiple 
successive logs from different channels while the original channel still has 
an alarm.  The log is stored after a short delay, to ensure the status of all 
channels has been updated before storing. 
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CChhaannnneell  33  OOvveerrllooaadd  

1133::3311  0011//0011//22000088 
    33::  TTrruussss  AA--33                            22116600KKgg  
    44::  TTrruussss  BB--11                            11664400KKgg  
    55::  TTrruussss  BB--22                            11664400KKgg  
    66::  TTrruussss  BB--33                            11664400KKgg  
    77::                                 UUnnuusseedd 

 
The log entries are shown starting with the most recent.  Use the bottom 2 screen buttons to navigate 
through the log entries.  The right hand button moves to the next older log entry, the left hand button moves 
to the next newer entry.  The screen will not refresh once you reach the last entry available. 
 

The top line of the screen shows the cause of the log entry. 
 
The next line shows the time and date of the log entry. 
 
The remaining lines show the weight at the time of the log entry of all the channels.  Use the up and 
down buttons, or numeric keypad, to select the channels to view. 

 
If a channel was not configured with a load cell at the time of the log entry then ‘Unused’ is displayed 
(this is regardless of whether the channel is now configured with a load cell). 

 
Note that the name shown for each channel is the name currently set for that channel. 

 
The Load Cell Monitor stores up to 200 log entries, and will overwrite old entries if necessary as new entries 
are created. 
 
 

UTILITIES MENU 
 

UUTTIILLIITTIIEESS MMEENNUU 
  
  
<<  VViieeww  CChhaannnneell  SSeettuupp  
<<  VViieeww  MMaaxx  WWeeiigghhttss  
<<  TTeesstt  AAllaarrmm                  VViieeww  PPHHCC>>  

 
View Channel Setup 
 Displays the setup of each channel as a list. 
 
View Max Weights 
 Displays the user set maximum weight of each channel as a list 
 
Test Alarm 
 Allows each of the alarm outputs to be simulated 
 
View PHC 

Only shown if the Load Cell Monitor has been setup to send load cell channels to an IBEX 
Programmable Hoist controller using port 4. 

 Displays the PHC load cell channels as a list 
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VIEW CHANNEL SETUP 
 

CChhaann                         PPoorrtt   IIDD 
    22::  TTrruussss  AA--22                                  11    5588  
    33::  TTrruussss  AA--33                                  22    668877  
    44::  TTrruussss  BB--11                                  22    1100  
    55::  TTrruussss  BB--22                                  33    9955  
    66::  TTrruussss  BB--33                                  44    6644  
    77::                                 UUnnuusseedd 

 
Each channel is shown together with is name if it has one.  To the right the port number (1-4) that the 
channel is setup to use is shown followed by the load cell ID number. 
 
The port is the XLR4 socket that the Load Cell Monitor 100 will use to communicate with the load cell. 
The ID is the load cells unique ID number that the Load Cell Monitor 100 will send when trying to read the 
weight from the load cell. 
 
‘Unused’ is displayed for channels that have not been setup to use a load cell.  
 
Use the up and down buttons or numeric keypad to select channel numbers to view. 
 
 

VIEW MAX WEIGHTS 
 

CChhaann                    MMaaxx WWeeiigghhtt 
    22::  TTrruussss  AA--22                            22000000KKgg  
    33::  TTrruussss  AA--33                            22000000KKgg  
    44::  TTrruussss  BB--11                                  NNoonnee  
    55::  TTrruussss  BB--22                                  NNoonnee  
    66::  TTrruussss  BB--33                                  NNoonnee    
    77::                                 UUnnuusseedd 

 
Each channel is shown together with is name if it has one.  To the right the user set maximum weight is 
shown. 
 
‘None’ is displayed for channels that have not been setup with a maximum weight.  
‘Unused’ is displayed for channels that have not been setup to use a load cell.  
 
Use the up and down buttons or numeric keypad to select channel numbers to view. 
 
 

TEST ALARM 
 

TTEESSTT AALLAARRMM 
  
  
<<  AAllaarrmm  OOuuttppuutt  11  OOffff  
<<  AAllaarrmm  OOuuttppuutt  22  OOnn  
<<  IInntteerrnnaall  AAllaarrmm  OOffff  

 
Press each of the 3 buttons to turn on or off the associated alarm output. 
 
The alarm outputs will be reset when exiting from this function. 
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VIEW PHC 
 

PPHHCC IIDD             OOuurr CChhaannnneell 
    11::                                        5500  
    22::                                        5511  
    33::                                        5522  
    44::                                        DDiissaabblleedd  
    55::                                        DDiissaabblleedd  
    66::                      DDiissaabblleedd 

 
This function is only available if the Load Cell Monitor has been setup to send load cell channels to an IBEX 
Programmable Hoist controller using port 4. 
 
Each PHC load cell ID is shown together with the Load Cell Monitor 100 channel that is configured to be 
sent to that PHC load cell ID.  ‘Disabled’ is displayed for PHC load cell ID channels that have not been 
configured with a load cell channel.  
 
Use the up and down buttons or numeric keypad to select channel numbers to view. 
 
The sending of load cell channels to a Programmable Hoist controller works on the following basis.  The 
Programmable Hoist Controller load cell port is connected to port 4 of the Load Cell Monitor 100.  The Load 
Cell Monitor will change its operation of port 4 so that instead of reading load cells it waits to receive load 
cell requests from the Programmable Hoist controller.  If a request is received for a PHC load cell ID that is 
configured to send a load cell channel then the Load Cell Monitor 100 responds with the current weight of 
that load cell channel.  Operation is completely normal for both the Load Cell monitor 100 and the 
Programmable Hoist controller, except that the Load Cell Monitor 100 cannot use port 4 to read load cells 
as normal and is therefore only capable of reading up to 75 load cells connected to the other 3 ports.  Each 
of the channels that is configured to be sent to the PHC is still displayed and monitored as normal by the 
Load Cell Monitor 100. 
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SETUP MENU 
 

SSEETTUUPP MMEENNUU 11 
  
  
<<  LLooaadd  CCeellllss                      NNeettwwoorrkk  >>
<<  MMaaxx  WWeeiigghhttss                        CClloocckk  >>
<<  SSeeccuurriittyy                                        NNEEXXTT  >>

 
SSEETTUUPP MMEENNUU 22 

  
  
<<  SSttaarrtt  CChhaann                    CCoonnttrraasstt  >>
<<  SSeenndd  PPHHCC              CClleeaarr  LLooggss  >>
<<  PPRREEVVIIOOUUSS                              NNEEXXTT  >>

 
SSEETTUUPP MMEENNUU 33 

  
  
<<  CCoonnffiigguurree  CCeellll                  RReesseett  >>
  <<  EEmmaaiill  
  <<  PPRREEVVIIOOUUSS                                

 
The setup menu is displayed across 3 screens.  Use the NEXT and PREVIOUS buttons to select between 
them. 
 
Load Cells 
 Setup the load cell channels 
 
Max Weights 
 Setup the maximum weights of each load cell channel 
 
Security 
 Setup a PIN code to restrict access to the setup menu 
 
Network 
 Setup the Ethernet network port 
 
Clock 
 Set the current time and data 
 
Start Channel 
 Set the start channel of the Load Cell Monitor 100 
 
Send PHC 
 Setup sending of channels to an IBEX Programmable Hoist Controller 
 
Contrast 
 Set the screen contrast 
 
Clear Logs 
 Erase all of the log data 
 
Configure Cell 

Using the Load Cell Setup port, discover the ID of a connected load cell and program a new ID into 
a connected load cell. 

 
Email 
 Configure automatic send and receive of email (Plus Model Only) 
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Reset 
 Reset the Load Cell Monitor memory back to the factory state 
 
 

SETUP LOAD CELLS 
 

CCHHAANNNNEELL TTOO SSEETTUUPP 
  

SSeelleecctt  tthhee  LLooaadd  CCeellll  
CChhaannnneell  ttoo  sseettuupp::  

11  
NNEEXXTT  >>

 
Select the load cell channel to setup.  This is the Load Cell Monitor 100 channel that will be used to read this 
load cell. 
 
 

CCHHAANNNNEELL PPOORRTT 
SSeelleecctt  tthhee  PPoorrtt  tthhee  

LLooaadd  CCeellll  iiss  ccoonnnneecctteedd  
ttoo,,  oorr  cclleeaarr  ttoo  ddiissaabbllee::  

33  
NNEEXXTT  >>

 
Select the load cell port that this load cell is connected to  If you want to clear this channel from being 
connected to a load cell then press the clear button and no further options will be presented. 
 
 

LLOOAADD CCEELLLL IIDD 
EEnntteerr  tthhee  LLooaadd  CCeellll  

IIDD  nnuummbbeerr::  
225566  

  
NNEEXXTT  >>

 
Enter the ID number of this load cell.  The ID number is the unique ID that is programmed into the load cell 
and is the address the Load Cell Monitor 100 uses to communicate with it. 
 
 

LLOOAADD CCEELLLL NNAAMMEE 
EEnntteerr  aanndd  ooppttiioonnaall  nnaammee  

FFoorr  tthhiiss  cchhaannnneell::  
TTRRUUSSSS  AA--11  

  
<<  BBLLAANNKK                                          NNEEXXTT  >>  

 
If desired a text name may be entered for this load cell channel which is displayed in the various Load Cell 
Monitor 100 screens with the channel number.  Use the numeric keypad to enter the name, pressing each 
button multiple times to select the desired character.  Press the BLANK button to clear the entered name. 
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SSEETTUUPP CCOOMMPPLLEETTEE 
                    CChhaannnneell  ::  11  
                                    PPoorrtt::  33  
          LLooaadd  CCeellll  IIDD::  225566  
    NNaammee::  TTRRUUSSSS  AA--11  
<<  CCaanncceell                                    SSTTOORREE  >>  

 
All of the required information has been entered and a confirmation screen is displayed.  To store the new 
setup for this channel press STORE, or to cancel without storing press Cancel. 
 
After setting up load cell channels you can confirm the changes made using the ‘Utilities’ > ‘View Channel 
Setup’ menu option. 
 
 

SETUP MAXIMUM WEIGHTS 
 

CCHHAANNNNEELL TTOO SSEETTUUPP 
SSeelleecctt  tthhee  FFiirrsstt  LLooaadd  

CCeellll  CChhaannnneell  ttoo  sseettuupp::  
11  
  

NNEEXXTT  >>
 
Enter the first load cell channel to setup. 
 

CCHHAANNNNEELL TTOO SSEETTUUPP 
SSeelleecctt  tthhee  LLaasstt  LLooaadd  

CCeellll  CChhaannnneell  ttoo  sseettuupp::  
11  
  

NNEEXXTT  >>
 
If you are setting the maximum weight of a single channel leave the last channel set to the same value as 
the first channel.  To set the maximum weight of a range of channels at the same time enter the last channel 
to setup.  
 

MMAAXX WWEEIIGGHHTT 
EEnntteerr  tthhee  mmaaxxiimmuumm  

WWeeiigghhtt  oorr  pprreessss  CClleeaarr  
ttoo  ddiissaabbllee::  

22000000  KKgg  
  

SSTTOORREE >>
 
Enter the maximum weight value.  This is the value that will be used by the Load Cell monitor to detect and 
overload condition and trigger an alarm.  If no alarm detection is required press Clear to disable the 
maximum weight function on this channel / these channels. 
 
After setting up maximum weights you can confirm the changes made using the ‘Utilities’ > ‘View Max 
Weights’ menu option. 
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SETUP SECURITY 
 

SSEETTUUPP SSEECCUURRIITTYY 
RReeqquuiirree  PPIINN  ttoo  eenntteerr  

SSeettuupp  mmeennuu::  
  

<<  EENNAABBLLEEDD  
NNEEXXTT  >>

 
To protect against unauthorised users altering the setup of the Load Cell Monitor 100 a PIN number may be 
set that must be entered when entering the Setup menu.  Enable or disable this function and then press 
NEXT or STORE. 
 

SSEETT SSEECCUURRIITTYY CCOODDEE 
EEnntteerr  sseeccuurriittyy  uunnlloocckk  

ccooddee::  
11223344  

SSTTOORREE  >>
 
If security has been enabled now enter the PIN code that must be entered to enter the Setup menu and then 
press STORE. 
 
Note that when security is enabled and the correct PIN code is used to enter the Setup menu, the Load Cell 
Monitor will unlock for 4 minutes, before re-locking and requiring the PIN code to be entered the next time 
the Setup menu is selected. 
 
In the event of the user password being forgotten the Load Cell Monitor 100 has a master password. This is ‘1846’. 
 
 

SETUP NETWORK 
 

NNEETTWWOORRKK MMEENNUU 
  
  
<<  VViieeww  SSttaattuuss  
<<  SSeett  IIPP  AAddddrreessss  
<<  SSeett  NNeettwwoorrkk  NNaammee  

 
View Status 
 View the current status of the Ethernet network connection 
 
Set IP Address 
 Set the IP address and Subnet mask to be used, or DHCP for automatic network setup. 
 
Set Network Name 
 Set the network name of the Load Cell Monitor 100 
 



 Load Cell Monitor 100 User Manual 18 

 

 

VIEW STATUS 
 

NNEETTWWOORRKK SSTTAATTUUSS 
      CCoonnnneecctteedd::  YYeess  ((DDHHCCPP))  
                    IIPP::  119922..116688..00..66  
  SSuubbnneett::  225555..225555..225555..00  
    NNaammee::  LLOOAADDCCEELLLL--MMOONN110000  

 
The current status of the network is shown: 

Connected ‘No’ if no network connection is present, or if DHCP is selected and no DHCP server 
has been found yet. 

 ‘Yes’ if the network connection is made.  If DHCP is selected then (DHCP) is also 
displayed to indicate that this is how the IP address and subnet mask we’re 
obtained. 

 
IP The Load Cell Monitor 100 IP address 
 
Subnet The Load Cell Monitor 100 subnet mask 
 
Name The Load Cell Monitor 100 network name 

 
The screen is refreshed every few seconds. 
 
 

SET IP ADDRESS 
 

IIPP SSEETTUUPP 
UUssee  mmaannuuaall  IIPP  aaddddrreessss  

oorr  DDHHCCPP  
  

<<  MMaannuuaall  IIPP  
NNEEXXTT  >>

 
Select manual IP address configuration or automatic DHCP IP address configuration.  DHCP stands for 
Dynamic Host Configuration Protocol and requires a network to have a DHCP server to issue IP addresses 
automatically.  When selected the Load Cell Monitor 100 will look for the DHCP server on power up and will 
connect to the network once an IP address and subnet mask has been obtained from the DHCP server. 
 
 

SSEETT IIPP AADDDDRREESSSS 
EEnntteerr  IIPP  aaddddrreessss::  

119922..116688..    00..111100  
  
  

<<  NNEEXXTT  VVAALLUUEE                    NNEEXXTT  >>  
 
If manual was selected now enter the IP address to be used.  Navigate between each of the 4 byte values 
using the NEXT VALUE button. 
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SSEETT SSUUBBNNEETT MMAASSKK 

EEnntteerr  SSuubbnneett  MMaasskk::  
225555..225555..225555..  00  

  
  

<<  NNEEXXTT  VVAALLUUEE              NNEEXXTT  >>  
 
Now enter the subnet mask to be used.  Navigate between each of the 4 byte values using the NEXT 
VALUE button.   
 

SSEETT GGAATTEEWWAAYY 
EEnntteerr  IIPP  AAddddrreessss::  

119922..116688..    00..    11  
  
  

<<  NNEEXXTT  VVAALLUUEE              DDOONNEE  >>  
 
Now enter the network gateway IP address.  This is required for email functionality, but may be set to 0.0.0.0 
if no gateway is present and email functions are not being used.  Navigate between each of the 4 byte 
values using the NEXT VALUE button.  Press DONE to finish.  
 
 

SET NETWORK NAME 
 

SSEETT NNEETTWWOORRKK NNAAMMEE 
EEnntteerr  NNeettBBIIOOSS  NNaammee::  
LLOOAADDCCEELLLL--MMOONN110000  

  
  

                                                                    SSTTOORREE  >>  
 
The default network name may be changed using this function.   
 
 

SETUP CLOCK 
 

SSEETT TTIIMMEE && DDAATTEE 
  
                SSeett  HHoouurrss::  1144  
  
  

  NNEEXXTT  >>
 
Use this function to set the current time and date.  Note that the time is entered as 24 hour. 
 
 

SETUP START CHANNEL 
 

SSTTAARRTT CCHHAANNNNEELL 
SSeett  cchhaannnneell  nnuummbbeerr  ffoorr  
TThhee  11sstt  cchhaannnneell  ooff  tthhiiss  

UUnniitt  ((DDeeffaauulltt  ==  11))  
11  

  SSTTOORREE  >>
 
If two Load Cell Monitor 100’s are being used together with the Hoist-Net PC application, or the Load Cell 
Monitor 100 is being used with a Programmable Hoist Controller and the Hoist-Net PC application then the 
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start channel may require setting to a value other than 1.  For instance if the Load Cell Monitor 100 is used 
with a single Programmable Hoist Controller, then the Programmable Hoist Controller will output channels 1 
-24 to the Hoist-Net PC application.  In this case the Load Cell Monitor 100 start channel should be set to 25, 
so that it outputs channels 25 – 124.  
 
When a different start channel is used this will alter the channel numbers displayed by and entered into the 
Load Cell Monitor 100 accordingly. 
 
If the Load Cell Monitor 100 is being used on its own then the start channel can be left as 1. 
 
 

SETUP SEND CHANNELS TO PHC 
 

SSEENNDD CCHHAANNSS TTOO PPHHCC 
SSeenndd  cchhaannnneellss  ttoo  

PPrrooggrraammmmaabbllee  HHooiisstt    
CCoonnttrroolllleerr  uussiinngg  

PPoorrtt  44::  
<<  EENNAABBLLEEDD                          SSTTOORREE  >>

 
The Load Cell Monitor 100 may be configured to send selected load cell channels to an IBEX Programmable 
Hoist Controller 
 
The sending of load cell channels to a Programmable Hoist controller works on the following basis.  The 
Programmable Hoist Controller load cell port is connected to port 4 of the Load Cell Monitor 100.  The Load 
Cell Monitor will change its operation of port 4 so that instead of reading load cells it waits to receive load cell 
requests from the Programmable Hoist controller.  If a request is received for a PHC load cell ID that is 
configured to send a load cell channel then the Load Cell Monitor 100 responds with the current weight of 
that load cell channel.  Operation is completely normal for both the Load Cell monitor 100 and the 
Programmable Hoist controller, except that the Load Cell Monitor 100 cannot use port 4 to read load cells as 
normal and is therefore only capable of reading up to 75 load cells connected to the other 3 ports.  Each of 
the channels that is configured to be sent to the PHC is still displayed and monitored as normal by the Load 
Cell Monitor 100. 
 
Enable or disable this function and press STORE. 
 
 

PPHHCC CCEELLLL IIDD 
SSeelleecctt  TThhee  PPHHCC  

LLooaadd  CCeellll  IIDD::  
11  
  

NNEEXXTT  >>
 
If this function is enabled now select the PHC load cell ID to setup.  The range of available ID’s is 1 – 24 and 
it is assumed that for ease of operation that the PHC will be setup with channels that use a load cell using a 
load cell ID that matches the PHC channel number (1-24). 
 
 

SSEENNDD OOUURR CCHHAANNNNEELL 
SSeelleecctt  tthhee  LLooaadd  CCeellll  
CChhaannnneell  ttoo  sseenndd  oorr  

PPrreessss  CClleeaarr  ttoo  ddiissaabbllee::  
5566  

SSTTOORREE  >>
 
Select the Load Cell Monitor 100 channel weight that should be returned when a request is received from 
the PHC for the selected ID.  If no channel should be returned press the Clear button to disable this PHC 
load cell ID (nothing will be returned by the Load Cell monitor if this ID is received from the PHC). 
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Link Cable 
A single twisted pair cable suitable for RS485 communications with overall screen should be used with an 
XLR4 plug fitted to each end: 

 
XLR4 Plug Cable XLR4 Plug 

1 Screen 1 
2 Pair – A 2 
3 Pair – B 3 
4  4 

Note that pin 4 must not be connected. 
 
 

SET SCREEN CONTRAST 
 

SSCCRREEEENN CCOONNTTRRAASSTT 
  
  

CCoonnttrraasstt  SSeettttiinngg::  3355  
  

SSTTOORREE  >>
 
Use the up and down buttons to alter the screen contrast and then press STORE.  
 
 

CLEAR LOGS 
 

CCLLEEAARR LLOOGGSS 
EERRAASSEE  AALLLL  LLOOGG  MMEEMMOORRYY  

PPrreessss  aanndd  hhoolldd  bbootthh  
BBuuttttoonnss::  

  
<<  RReesseett                                              RReesseett  >> 

 
This function will clear the Load Cell Monitor 100 log memory. 
 
 

CONFIGURE CELL 
 

CCOONNFFIIGGUURREE CCEELLLL 
CCoonnnneecctt  aa  ssiinnggllee  llooaadd  
cceellll  ttoo  tthhee  LLooaadd  CCeellll  

SSeettuupp  ppoorrtt..  
  

<<  SSeett  IIDD::  11                                            EExxiitt  >>
 
This function may be used when installing a new system to program the node ID of individual load cells (and 
confirm they are functioning).  The node ID of a load cell is its RS485 communications address that is 
typically programmed by the load cell manufacturer when a new load cell is made. 
 
Connect the load cell to the ‘Load Cell Setup’ port on the rear of the Load cell Monitor.  Ensure that only 1 
load cell is connected.  (If the cable is short there is no need for a terminating resistor to be added to the end 
of the cable). 
 
Use the up and down buttons or numeric keypad to enter a new node ID value and then press the Set ID 
button.  The screen will confirm the ID is being set by displaying “Setting…” followed by “SUCCESS!” or 
“FAILURE!”.  If failure is displayed then the cell did not respond using the new address so there is a fault 
with the cell of the cable. 
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There is a delay of approximately 4 seconds while the node ID is set.  This is due to the Load Cell Monitor 
assuming that a new load cell may have been connected for the first time each time the Set ID button is 
pressed.  It therefore carries out all of the initialisation functions required for a new load cell to talk to the 
Load Cell Monitor and then programs the node ID.  This process requires the load cell to be reset twice 
which is why there is a delay for it to complete. 
Note that this function is not required to be used for new cells.  The initialisation procedure of all load cells 
is also carried out automatically on each port each time the Load Cell Monitor is powered up. 

 
 
 

EMAIL 
 

EEMMAAIILL SSEETTUUPP 
CCoonnffiigguurree  aauuttoommaattiicc  

sseenndd  &&  rreecceeiivvee  ooff  eemmaaiill  
  <<  SSeenndd  EEmmaaiill  SSeettuupp  
  <<  RReecceeiivvee  EEmmaaiill  SSeettuupp  
  

 
Email functions are available on the Load Cell Monitor 100 Plus model only. 
 
The Load Cell Monitor may be configured to automatically send an email to a pre-set address every time an 
alarm event occurs and optionally every day, week or month.  The email sent will contain details of the alarm 
event that occurred or the current live weights of each load cell and will have a .csv spreadsheet log file 
attached containing details of the most recent log events. 
 
The Load Cell monitor may also be configured to automatically check a POP3 mailbox periodically (hourly) 
for an email addressed to it.  When a valid email is received the Load Cell monitor will automatically reply 
with the current live weights of each load cell and with a .csv spreadsheet log file attached containing details 
of the most recent log events. 
 
Send email setup 
 Follow the prompts to enter the following information: 
  Enable send email 
  SMTP server (up to 30 characters) 
  Login username (also the ‘from’ email address that will be used) (up to 30 characters).  
  Login password (up to 16 characters).  Leave blank if is authentication not required. 
  Send to email address (up to 30 characters) 
 

Then select whether emails should be sent daily, weekly, monthly or none except alarms. 
 
On completion of the send email setup the Load Cell Monitor will immediately attempt to send an 
email (this will occur even if the settings have not be altered and may be used to test emailing). 

 
Receive email setup 
 Follow the prompts to enter the following information: 
  Enable receive email 
  POP3 server (up to 30 characters) 
  Login username (up to 30 characters) 
  Login password (up to 16 characters) 

Subject line ID value that must be present in an email for this Load Cell Monitor to read it 
and respond. (0000 – 9999) 

 
On completion of the receive email setup the Load Cell Monitor will immediately check for received 
email (this will occur even if the settings have not be altered and may be used to test emailing). 

 
To request the Load Cell Monitor to respond via email simply send an email to the POP3 mailbox, 
with the subject line contents starting with the ID value entered.  The Load Cell Monitor will check 
the POP3 mailbox for email every hour. 
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For the Load Cell Monitor to be able to receive and send emails the connected Ethernet network must 
provide a gateway to the internet.  This is typically a simple router or server that provides the connection to 
the internet for network devices. The router or server must provide DNS lookup functionality (i.e. when the 
Load Cell Monitor sends a DNS request to the gateway it must perform the DNS lookup and return the 
address - this is a typical gateway function). 
 
 

RESET MEMORY 
 

RREESSEETT MMEEMMOORRYY 
RReesseett  aallll  mmeemmoorryy  ttoo  

uunn--pprrooggrraammmmeedd  ssttaattee..  
PPrreessss  aanndd  hhoolldd  bbootthh  

BBuuttttoonnss::  
<<  RReesseett                                              RReesseett  >> 

 
This function will reset the Load Cell Monitor 100 memory back to the factory default state.  All setup 
configuration will be deleted. 
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HOIST-NET PC APPLICATION 
 
 

CONNECTING A PC TO THE NETWORK 
 
For a PC to be able to connect to a Load Cell Monitor 100 it will need an Ethernet port, and its networking 
parameters setup to match the Load Cell Monitor 100.  Different versions of Windows deal with network 
settings in slightly different ways, but the following, based on Windows XP, is a good guide: 
 

 
 

Go to the Windows Control Panel and select the ‘Network Connections’ icon. 
 

Select the network connection to be setup.  You may have more than 1 connection in which case select the 
one that is for the wired Ethernet port (i.e. not Bluetooth, not Wireless etc).  

 

 
 
 

Double click it to open the connection window. 
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There should be a ‘Local Area Connection’ / ‘Internet Protocol’ specified as ‘TCP/IP’ for the network port (if 
not you need to create one using ‘install).  

 
Select the TCP/IP protocol line and then select ‘Properties’. 

 
Using DHCP 

If your network has a DHCP server (for example a router in a simple network setup) then you may 
select the ‘Obtain and IP address automatically’ option to configure the PC to automatically get its 
network settings from the DHCP server.  (The Load Cell Monitor 100 may also be configured to use 
DHCP). 

 
Using a manual IP address 

If no DHCP server is available, or if you are also using an IBEX Programmable Hoist Controller, then 
enter the network settings manually. 
 
 Select the ‘Use the following IP address’ option.  Then enter ‘192.168.0.10’ for the ‘IP Address’ and 
‘255.255.255.0’ for the ‘Subnet Mask’.  Select OK.  A DNS server address is not required. 
 
Note that if more than 1 PC is to be connected to the network, each PC will require its own unique IP 
Address, i.e. 192.168.0.11 for the second PC etc.  The ‘192.168.0’ is the subnet part of the address 
which is fixed, the final number can be any number between 1 and 254.  The only requirement is that 
is must be unique on the network.  The PHC+ controllers use IP addresses 192.168.0.150 to 
192.168.0.159 by default). 
 

Your computer may have more than 1 Ethernet port, say a wired RJ45 socket and a wireless WiFi card.  
When using the Hoist Net-PC software it is advisable to disable any other Ethernet ports so that the software 
has no confusion about which Ethernet port to use.  You can do this by right clicking on the other connection 
in the ‘Network Connections’ window and selecting ‘Disable’. 

 
Your PC should now be setup to communicate with the Load Cell Monitor 100. 

 
Note that if your PC is running any ‘firewall’ software, including Windows Firewall, this may automatically 
block communications between the PC and the Load Cell Monitor 100.  The easiest way to determine this is 
to turn off the firewall software (with the computer disconnected from the Internet) and then see if network 
communications work correctly.  Most firewall software will prompt you the first time you run Hoist-Net PC to 
ask if you wish to allow it through the firewall, but if not consult you firewall software documentation for 
further information 
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THE HOIST-NET PC APPLICATION 
 
The application ‘Hoist Net-PC’ is available free of charge from IBEX.  This application allows one or more 
PC’s to show a full screen status display for up to 2 connected Load Cell Monitor 100’s and up to 10 
Programmable Hoist Controllers.  Note that when using the application with only a Load Cell Monitor 100 
some of the functions are not relevant and are therefore not covered in this manual.  
 
The main screen 
 

 
 
Operation 

When the Load Cell Monitor is connected to the network the status of each channel will be displayed 
in its status box. 
 
There are 10 separate screens, each of which may be configured to display a different set of 
channels.  The channel status boxes may be moved around the screen, by dragging their blue 
channel number bar.  This allows the status boxes to be laid out to represent the real world layout of 
the load cells being monitored.  Use ‘View’ > ‘Display Channels’ from the menu to select which 
channels are displayed for each screen. 
 
Use the ‘File’ menu to store screen layouts. 

 
 
Network Status 

Use ‘Tools’ > ‘View Network’ from the menu to display the current network status: 
 

 
 
 Each connected device is displayed together with its configuration. 
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Export Current Weights 

Select this option from the Tools menu to export the current weight of each channel to a Microsoft 
Excel compatible .csv spreadsheet file. 

 
System Requirements 

An IBM-compatible PC running Windows 95, Windows 98, Windows ME, Windows 2000 or Windows 
XP. 

 Pentium 200MHz or higher processor 
 64MB RAM 
 CDROM drive 
 10BaseT compatible network card 
 
 
Installation 
 Insert the application CDROM in the computers CDROM drive. 
 Select the start menu followed by the Run command. 
 Press browse and locate the CDROM drive. 
 Select the programme ‘setup.exe’ and press ‘Open‘. 
 Press ‘OK’ to run the setup procedure. 
 Follow the on screen instructions 
 
 

COMMISSIONING A NEW SYSTEM 
 
If all of your cabling and load cells function correctly then commissioning a new system will be as simple as 
configuring each of the required Load Cell Monitor channels to read each of the load cells.  Once complete it 
is recommended that each load cell is physically verified that it has been configured to the correct Load Cell 
Monitor 100 channel.  For instance you may be able to hang or stand on each load cell and verify that the 
correct channels weight changes on the Load Cell Monitor 100 screen.  Alternatively you may be able to 
operate the equipment that causes each load cells reading to change and verify that the correct load cell 
channel reading changes for each load cell tested.  This testing is important to ensure that incorrectly 
entering a load cell ID number, for instance, doesn’t confuse operators or worse fail to generate an alarm in 
an overload condition. 
 
Always ensure that the terminating resistor has been correctly fitted at the last load cell connection.  If this 
resistor is not fitted intermittent communication faults can be caused, even if the system appears to be 
working without problems. 
 
Problems With Commissioning 
If you experience problems commissioning a new system the following are useful tips to help solve the 
problem:- 
 

If you have multiple load cells connected to a port on the Load Cell Monitor then start by 
disconnecting all of the load cells except the first one.  Ensure the Load Cell Monitor 100 is 
configured to read the weight from this load cell.  Once the first load cell is working connect the next 
load cell and repeat.  At some point you will find that connecting the next load cell doesn’t work, or 
even causes the previous load cells to stop working.  This has then identified the point where there 
is faulty cable connection (likely) or a faulty load cell (less likely). 
If your load cells have never been connected to the Load Cell Monitor 100 before then you should 
cycle the power to the Load Cell Monitor 100 after each new load cell is connected when following 
this procedure.  This is because the load cells may have previously been configured to use a 
different BAUD rate to the rate used by the Load Cell Monitor 100.  The BAUD rate command is 
transmitted by the Load Cell Monitor 100 every time it is powered up, so if there was a cable fault 
when it was last powered up the connected load cells may have not received the previous BAUD 
rate setting command. 

 
Check the voltage at the last cell load cell connection on a port.  Whilst there will be some voltage 
drop along a long cable run it should not be too significant.  The Load Cell Monitor outputs between 
11.5V and 12.5V (DC, on XLR pins 1 and 4).  If the voltage reading after a load cell is below around 
7.0V then there is either a connection problem of the gauge of cable being used is not big enough. 
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Ensure that the terminating resistor has been correctly fitted at the last load cell connection.  If this 
resistor is not fitted intermittent communication faults can be caused. 
 
Ensure there are no ‘Y’ splits in the cable run.  Very short ‘Y’ splits at individual cells are acceptable 
for cells that have only a single cable connection, but the main cable run must not be split into two or 
more separate cable runs. 

 
Ensure that good RS485 data cable installation practice has been followed.  Cable screens should 
be kept isolated from metalwork where possible to avoid the possibility of ground loops.  Good 
quality cable with shielding suitable for RS485 communications should have been used and the pair 
of data cores should be twisted. 
 
If you have a cell that you are unable to get to work the ‘Configure Cell’ function, which is described 
earlier in this manual, may be used to try and reset the cell’s communication ID.  This function will 
confirm if the process was successful, and therefore confirms if the cell is working as well as 
ensuring it has been configured with the ID you think it has been configured to use. 
 
If an alarm is being triggered due to cells not responding you may press the Silence button a second 
time to hide the alarm screen and view the general status screen, allowing you to see the status of 
all cell channels.
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SPECIFICATIONS 
 
Size 
 2U 19” rack mount unit, 220mm deep 
 
 
Mains Input 

IEC plug 
 Mains input voltage   85 – 260VAC 50/60Hz 

Operating current Up to 1.65A (10A type C circuit breaker recommended for 
brief power on surge current) 

 
This product must be earthed. 

 
 
Load Cells 

This product is designed to be used with load cells that incorporate the Mantracourt DCell RS485 
ASCII load cell amplifier.  Each load cell should incorporate a 4 pin ‘in’ and a 4 pin ‘out’ connection. 
 
Note that Load Cell Monitor 100 will automatically set the baud rate of the load cells on power up 
to 4 (38K4) if the load cells have previously been set to baud rate 7 (115K2), 6 (76K8), 5 (57K6), 
3 (19K2) or 2 (9K6). 

 
 Output voltage    12V DC 
 Max current per port   1.6A (protected by internal self resetting electronic fuses). 
 
 See connections section for cable requirements. 
 
 Load cell weight resolution  1.0Kg 
 

Allowable load cell weight range 0Kg to +59999Kg (negative weight readings are accepted 
but are converted to 0Kg) 

 
 Maximum number of load cells per port 25 
 

Maximum total number of load cells 100 (75 if Load Cell Monitor 100 is configured to send load 
cell channels to an IBEX Programmable Hoist Controller)  

 
Load cell update time All 25 channels on a single port are normally updated every 

500mS.   Individual ports function independently from each 
other. 
Maximum update time 1.5 seconds (if all channels on a port 
are not responding or if older slow to respond load cells are 
used). 

 
 Alarm trigger time   Between 1x and 2x the load cell update time 
 
 Mantracourt DCell sampling rate  5Hz 
 
 
Alarm Output 

Two normally open volt free relay contacts rated at 500mA 24VDC. 
 
12V DC power output that may be used to power external devices if required.  Maximum current 
900mA (protected by an internal self resetting electronic fuse). 

 
 
Ethernet 

10Base-T     Neutrik Ethercon socket (standard RJ45 compatible) 
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